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EMEETING INTRODUCTION 
Global Crossing eMeeting (Powered by WebEx) is a full featured web conferencing service that 
enables rich, collaborative sharing of applications. Integrated with Global Crossing’s Ready-
Access® audio, eMeeting gives you the control and functionality you need to make the most out 
of your virtual meetings with the benefits of an in-person meeting 

eMeeting benefits  

Collaboration Made Simple 

Geography is no longer an obstacle and your reach is virtually unlimited. With a rich set of tools 
you completely customize and manage meetings as well as engage the audience allowing you 
the opportunity to accomplish your objectives faster.  

Rich, Real-Time Collaboration 

Share, collaborate and discuss in real time as if everyone were gathered around one table. 
Advanced interactive tools give you the capability to effectively communicate ideas leading to 
faster decision making 

Enhanced Security  

eMeeting deploys a globally-distributed network of high-speed MediaTone switches. This unique 
architecture allows session data originating from the Presenter’s machine and arriving at the 
Attendees’ machines to be switched. This is unlike other web meeting solutions that use a store 
and forward server model where potentially sensitive content is persistently stored on vendors’ 
equipment. 

Less Travel  

Collaborating online and in real time means you can accelerate project cycles and drive business 
growth without having to travel as often. This eliminates downtime and increases productivity 
while reducing expenses which means a better bottom line. 

Perfect For Groups Of All Sizes 

eMeeting is flexible and scalable and can accommodate groups up to 500. It’s perfect for small 
collaborative department meetings or large events style meetings keeping communications 
current and fresh meaning the business at hand is not lost. 

Seamless Audio Integration 

eMeeting is integrated with Ready-Access audio conferencing to give you the convenience of a 
single sign on making your web conferences as simple, efficient and empowering as you’ve ever 
imagined.  
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GETTING STARTED: 

Starting An eMeeting 
You can login to Ready-Access eMeeting using your Ready-Access numbers and you can control 
your audio conference using the Ready-Access controls that are integrated in eMeeting.    

 

1. Go to www.globalcrossing.com/conferencing  

2. Go to eMeeting in Quick Links 

3. Select Access Your Account  

 

 

 

4. When the Ready-Access Login screen is 
presented, enter your Ready-Access phone 
number, seven-digit access code and Chairperson 
pass code.  Press Go. 

 

 

 

 

 

 

5. The eMeeting application will launch and the My 
WebEx page will open displaying a list of 
previously scheduled meetings. Click on the 
meeting you wish to launch from the meeting 
topic list. 

 

 

 

 

 

Note 
You can also click the eMeeting link which will take 
you to the eMeeting web page and log in from that 
location. 

The Meeting Center allows eMeeting Hosts to view their list of scheduled meetings, create/schedule, edit, 
and delete meetings, start instant meetings, store documents in online folders, add entries into their 
eMeeting address book, and access online support documents.  
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Scheduling An eMeeting 
1. Go to www.globalcrossing.com/conferencing  

2. Go to eMeeting in Quick Links 

3. Select Access Your Account  

 

 

4. Click on Meeting Center (top left).  From 
here you can  

�  Host a meeting 

�  Attend a meeting 

�  Access your set up options 

�  Seek Assistance if you have an 
eMeeting question 

5. Click on the drop down 
arrow under “Host a Meeting” to show three options 

�  Schedule a meeting 

�  My Meetings (access to the My WebEx page as seen in “Starting 
an eMeeting”) 

�  Instant Meetings 

 

6. Click on Schedule a Meeting.  Fill in the meeting topic 
and click the Date & Time tab. 

 

 

 

 

Note 
You can also click the eMeeting link which will take 
you to the eMeeting web page and log in from that 
location. 

Note 
Required information is highlighted with purple text 



                                   eMeeting User Guide 

7. Choose the desired date and time of the meeting.  Also 
select  

�  The meeting duration 

�  Select whether it’s a re-occurring meeting 

8. Click Next 

9. The audio conferencing portion of the meeting is delivered 
through your Ready-Access®. A message to that effect 
appears as part of the third step in setting a meeting.  Click 
Next. 

10. You can invite attendees two ways 

�  By typing the address through eMeeting 

�  By clicking select attendees and using the company address 
book to select meeting participants   

 

11. Click Next 

 

 

12. Determine if you want your meeting participants to 
register for the meeting and select accordingly.  

When attendees register, by default they will be 
prompted to enter their first name, last name and 
email address. You may also gather additional 
information by clicking the box next to the information 
you seek to obtain.  Click Next. 

 

13. Create an agenda.  You can also upload your presentation by 
following the on-screen step-by-step procedure once. Choose 
the presentation you want to share via the Browse button. 
Click Next. 

 

 

 

Note 
eMeeting will send participants a 
meeting reminder 15 minutes 
before the scheduled meeting 
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14. Choose options for participants and click Next 

�  Chat allows participants and presenters to communicate 
to each other through the web interface 

�  Notes gives participants a place to store information or 
questions  

�  Closed captioning allows people hard of hearing to read 
a transcript or dialogue of the audio portion of a video, 
film, or other presentation 

�  File Transfer enables participants to send or receive files in a meeting 

�  Recording Enables the real-time recording of on-line meetings, and off-line recording 
of any application. Recording can be posted on a web site for playback over the 
Internet 

�  UCF Rich Media for attendees supports Microsoft PowerPoint™ slide builds, 
animations, and transitions. 

15. The next step sets up the attendee options including 

�  Saving file 

�  Printing presentations 

�  Annotating 
�  Viewing participant’s lists 

�  Viewing thumbnails 

�  Remotely controlling application, web browsers 
�  Viewing any document or page 

�  Allowing chat among and with participants, hosts, and presenters 

16. Click Next 

17. Review your meeting and press Schedule 
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Joining An eMeeting 
You can join an eMeeting in two different ways.  The first is via the web site and the second is 
through a link in your meeting invitation. 
 

Joining an eMeeting from a Browser 

 
1. Go to www.globalcrossing.com/conferencing  

2. Go to EMeeting in Quick Links 

3. Select Join A Conference 

 

 

 

 

 

 

 

4. When the eMeeting Login screen is presented, enter the meeting 
number and click “Join Now” 

 

 

 

5. Enter your name and e-mail address and click Go. 

 

 

 

 

 

 

Note: 
The meeting number will be in the eMeeting invite 
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Joining an eMeeting from an Email Invitation 

1. Open the meeting invitation you receive from the meeting 
organizer 

2. Follow the steps outlined in the e-mail to log into the 
eMeeting and from follow step 4 in “Joining an eMeeting 
from a Browser” 

 

 

 

 

 

 

 

3. When the eMeeting Login screen is presented, enter the meeting 
number and click “Join Now” 

 

 

 

 

 

4. Enter your name and e-mail address and click Go. 

 

 

 

 

 

 

Note: 
The meeting number will be in the eMeeting invite 
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UNDERSTANDING THE MEETING WINDOW 
This section gives a brief overview of the Meeting window.  
The left side of the Meeting window displays the content 
viewer, where you share documents, applications, and 
other items with attendees. The right side of the window 
contains panels, which you can display or hide as you 
need them. For example, you may want to send a quick 
chat message to a participant. You can minimize or close 
the Chat panel after your exchange, to reduce the clutter 
or provide more space for another panel. Panels are just a 
click away, so you can open a panel quickly. If you’ve 
closed a panel and it needs your attention, you receive an 
alert.  
 
 

Menu Bar 
A menu bar appears at the top of the Meeting window 

 

File Provides commands for saving, opening, transferring, or printing files during a 
meeting; and ending or leaving a meeting. 

Edit Provides commands for editing shared content in the content viewer. 
Share Provides commands for sharing documents, presentations, applications, Web 

browsers, desktops, remote computers, multimedia Web pages, and 
whiteboards. 

View Provides commands for displaying information in the content viewer on a 
host©s, presenters, or attendee©s screen. 

Communicate Provides commands for setting up a teleconference and other audio features. 
Participant Provides commands pertaining to participants, such as inviting a participant to 

a meeting, assigning roles and privileges, providing remote control, controlling 
participants’ audio, and so on. 

Meeting Provides commands pertaining to the meeting, such as viewing meeting 
information and restricting access to the meeting. 

Help Provides information about the product 

Content Viewer 

The content viewer displays one or more documents, presentations, applications, and 
whiteboards that you share during a meeting. Document tabs at the top of the viewer allow you to 
switch among multiple shared documents, presentations, and whiteboards. 
. 
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Sharing Icons 

You can open a document, whiteboard, desktop, or application to share 
using the sharing icons in the upper left corner:  

As you start sharing documents and applications during your meeting, tools are available at your 
fingertips.  

 

You now have access to: 

�  Annotation tools for highlighting and referring to elements in the presentation or 
application you are sharing 

�  View tools for displaying document and presentations in different ways, such as showing 
thumbnails of the pages 

�  Previous and Next buttons, for moving around in a document 

Annotation Tools 

Use the Annotation tools to “mark up” slides when in Slide Presentation. Select an annotation tool 
by clicking on it; to deselect it click on the tool again.  These annotations on your presentation will 
be seen by participants.  If you are recording your 
eMeeting, the annotations will be recorded as 
well.  You will be able to select from the following  

Pointer Lets you point out text and graphics on shared content. The pointer displays 
an arrow with your name and annotation color. To display the laser pointer, 
which lets you point out text and graphics on shared content using a red 
“laser beam,” click the downward-pointing arrow. Clicking this button again 
turns off the pointer tool. 

Text Lets you type text on shared content. Attendees can view the text once you 
finish typing it and click your mouse in the content viewer, outside the text 
box. To change the font, on the Edit menu, choose Font. Clicking this button 
again turns off the text tool. 

Line Lets you draw lines and arrows on shared content. For more options, click the 
downward-pointing arrow. Clicking this button closes the Rectangle tool. 

Rectangle Lets you draw shapes, such as rectangles and ellipses on shared content. For 
more options, click the downward-pointing arrow. Clicking this button again 
closes the Rectangle tool. 

Highlighter Lets you highlight text and other elements in shared content. For more 
options, click the downward-pointing arrow. Clicking this button again closes 
the Highlighter tool 

Annotation 
Color 

Displays the Annotation Color palette, on which you can select a color to 
annotate shared content. Clicking this button again closes the Annotation 
Color palette. 

Eraser Erases text and annotations or clears pointers on shared content. To erase a 
single annotation, click it in the viewer. For more options, click the downward-
pointing arrow. Clicking this button again turns off the eraser tool. 
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View Tools 

The view tools allows you to see the material based on 
your own personal preference 
 
Standard View Clicking Standard View displays the shared content as you would normally 

view it.  
Thumbnails Clicking thumbnails displays miniatures of shared pages, slides, or 

whiteboards. This tool helps you locate a page or slide quickly 
Full Screen Displays shared content in a full-screen view. Helps you to ensure that 

participants can view all activity on your screen. Also helps to prevent 
participants from viewing or using other applications on their screens during a 
presentation. Click ESC to return to the content viewer. 

Zoom In/Zoom 
Out 

Lets you display shared content at various magnifications. Click this button, 
and then click the page, slide, or whiteboard to change its magnification. For 
more magnification options, click the downward-pointing arrow. 

Synchronize 
Display for All 

For presenters, synchronizes all participants© displays with your display. 
Helps to ensure that all participants are viewing the same page or slide, at 
the same magnification, as in your display 

WORKING WITH PANELS 
The panels on the right side of the sharing window are very flexible. You can expand, close, or 
minimize them quickly and easily. You can also reduce the panels to icons, providing greater 
space for sharing documents, applications, and other items with meeting participants. 
 

Panel Overview 
The Power Panels enable presenters to run full screen presentations, applications, or desktop 
sharing while transparently managing meeting functions such as chat, attendee lists and notes.   

Polling 

Enables presenters to solicit group or individual feedback from 
attendees. Results are tabulated and displayed in the meeting. 

Polls allow presenters to receive instant feedback from their audience 
in real-time, as seen in the accompanying screen shot. Polls can be 
created in advance using Microsoft PowerPoint or during the meeting 
by clicking the poll button. The poll will be instantly displayed or 
hidden (based on the presenters’ preference) and audience votes are 
tallied dynamically. At the end of the session a polling report can 
show how specific individuals voted as well as aggregate total 

Creating polls will be discussed in a later section. 
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Notes 
Provides a field for a designated minutes-taker to record & 
share meeting minutes for improved process & records. If the 
meeting host or presenter has selected the option to allow 
participants to take personal notes, you can type your notes 
on the Notes panel in the Meeting window. During a meeting, 
one or more meeting participants with access to the notes 
feature can take notes on the Notes or Closed Caption 
panel in the Meeting window. Only one participant performs 
closed captioning. If all participants with access take notes, they cannot publish their notes to 
others during the meeting. However, participants can save their notes at any time during the 
meeting. The meeting host can select the single note taker during the meeting. A single note 
taker can publish notes at any time during the meeting or send a meeting transcript containing the 
notes to all participants. If needed, the host can also select a closed captionist. A closed 
captionist can publish captions in real-time during the meeting and can also send a transcript 
containing the captions to all participants 

Chat 

Chat allows participants and presenters to communicate 
to each other through the web interface. Chat is also a 
way to ask questions during a conference. eMeeting 
includes several ways to enhance your conference 
experience. Some of the most common uses for chat are: 

�  Coordinate presentations between 
presenters 

�  Coordinate presentations between a 
participant and presenters 

�  Conduct a Question & Answer session 

�  A method for participants to ask questions 

To send a message, use the drop down box to choose which participant should receive the 
message, type the message in the text field then press the “Send” button.   

 

Participants 

The Participants Panel allows meeting participants to see 
who is attending the meeting, event, or training. The panel 
lists attendee names. The Attendee Profile allows meeting 
attendees and presenters to set their user profile to display 
information about themselves to other participants. 
Attendees can provide name, title, company, email, phone 
number, and attach a personal photograph.  

Tools 

The Tools Panel gives you a list of available tools and 
allows you to see where in the presentation you are and 
gives you the ability to manage and manipulate the 
presentation. 
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Minimizing and Restoring Panels 
Minimizing or restoring 
panels has no effect on 
attendees’ displays. To 
minimize a panel: Click 
the Minimize icon on the 
title bar of the panel you 
want to minimize. The 
panel no longer displays. 
It appears as an icon on 
the icon tray at the top of 
the panels. 
 
To restore a minimized panel click its icon 
on the icon tray 
 
 
 
 

To minimize all panels  

1. On the icon tray, click Panels. The Select Panel menu 
displays. 

2. On the Select Panel menu, choose Minimize All. The open panels shrink to icons on the 
icon tray. 

To restore all minimized panels simply select the Restore All command  

1. In the icon tray, click Panels. The Select Panel menu displays. 

2. On the Select Panels menu, choose Restore All. Minimized panels now display 

Panels And Full Screen View  
While you are viewing a document or remotely controlling a shared application, desktop, or Web 
browser, or viewing a shared remote computer, a presenter can switch between a standard 
window and full-screen view. In full-screen view, you access the panels on a floating icon tray 
located in the lower right corner of your screen. 

 

 

 

 

 

To display a panel in full screen mode click its icon on the floating tray. The panel “floats” on top 
of the shared document, presentation, web browser or other shared item. You can drag the panel 
to move it. 
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PANEL ALERTS 
If you have closed, minimized, or collapsed any panels, you will see an alert if a panel you no 
longer can see requires your attention. Some reasons for seeing alerts: 

�  A participant arrives or leaves a meeting 

�  A Raise Hand indicator appears in the Participants list 

�  The note taker publishes notes 

�  An attendee sends a chat message 

�  A poll opens or closes 

�  Poll answers are received 

 

Alerts for Closed, Minimized or Collapsed Panels 

If you have closed, minimized or collapsed a panel, the Panels button changes color to alert you 
to a change. Participant’s panel, the Select Panel menu button turns into an alert. 

 

 

 

 

 

 

 

 

 

 

  

POLLING 
During a meeting, you can poll attendees by presenting them with a questionnaire. Conducting a 
poll can be useful for gathering feedback from attendees, allowing attendees to vote on a 
proposal, testing attendees’ knowledge of a topic, and so on.  To conduct a poll, you must first 
prepare a poll questionnaire. You prepare a questionnaire during a meeting. To save time during 
a meeting, you can prepare a questionnaire by starting the meeting earlier than the scheduled 
time, save it, and then open it during the actual meeting. Once you close a poll, you can view the 
results and share them with attendees. You can also save the results of a poll for viewing outside 
a meeting. 
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Preparing a Poll Questionnaire 
Presenter only 
On the Polling panel, you can create a poll questionnaire that includes multiple-answer, single-
answer, or text questions. You can also specify options for displaying a timer during polling and 
poll results. Once you complete a questionnaire, you can open the poll at any time during a 
meeting. 

Creating a Poll Questionnaire 
Presenter only 
You can create a questionnaire at any time after you start 
a meeting. The following figure shows a portion of the 
Polling panel, which offers the tools you use to compose 
a questionnaire. 

 

To create a questionnaire: 

1. Open the Polling panel.  

2. In the Question section, select the type of 
question you want to create by doing one of the 
following: 

�  To create a multiple-answer question, 
select Multiple Choice, and then choose 
Multiple Answers in the drop-down list. 

�  To create a single-answer question, 
select Multiple Choice, and then choose 
Single Answer in the drop-down list. 

�  To create a text question, select Short 
answer. 

3. Click New. 

4. Type a question in the box that appears. 

5. In the Answer section, click Add. 

6. Type an answer in the box that appears. 

7. To type another answer, click Add once you finish typing an answer. The question and 
answers appear in the Poll Questions area. 

8. To add questions, repeat steps 2 to 7. 

Editing a Poll Questionnaire 

Presenter only 

You can change the type of a question and edit, rearrange, or delete the questions and answers. 
To change the type of a question: 

1. Select the question by clicking it, and then select the new type of question in the Question 
section. 

2. Click Change Type. 
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Making changes  

1. To edit any question or answer that you typed: Select the 
question or answer by clicking it, and then click the Edit 
icon.  Make your changes. 

 

2. To delete a question or an answer: Select the question or 
answer by clicking it, and then click the Delete icon.  

 
 

3. To rearrange questions or answers: Select the question or 
answer by clicking it, and then click the Move Up or Move 
Down icon, as appropriate.  

 

4. To delete an entire questionnaire: Click Clear All. If you have not saved the 
questionnaire, a message box appears, asking whether you want to save it or not. 

Displaying a Timer in a Poll 
Presenter only 
You can specify that a timer displays for attendees and yourself when a poll is in progress. To 
display a timer: 

1. Click Options at the bottom of your Polling panel.  

2. In the dialog box that appears, select Display, and then type the length of time in the 
Alarm: box. 

3. Click OK. 

Opening a Poll 
Presenter only 
After you finish preparing a poll questionnaire, you can open the poll. If you prepared your 
questionnaire in advance and saved it, you must first open it on the Polling panel. To open a poll: 

1. Open the Polling panel. 

2. Click Open Poll. 

The questionnaire appears on attendees’ 
Polling panels. Attendees can now fill out 
the questionnaire. As attendees answer 
the questions, you can watch the polling 
status on your Polling panel. Click Close 
Poll when the time is up. If you specify a 
timer and the poll times out, the poll 
automatically closes. Attendees can no longer answer questions. Once you close a poll, you can 
view the poll results and optionally share them with attendees 
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Viewing Poll Results 
Once you close a poll, you can view the complete results of the poll and 
share them with attendees. The Results column indicates the percentage 
of attendees who chose each answer. The Bar Graph column provides a 
graphic representation of each percentage in the Results column. 

Sharing Poll Results 
Presenter only 
After you close a poll, you can share the poll results with participants. To share the results of a 
poll: 

1. In the Share with attendees section on your Polling panel, select Poll results. 

2. Click Apply. 

The results of the poll appear in the attendees’ Polling panels, just as they appear in your 
Polling panel. 

Saving a Poll Questionnaire 

Presenter only 

Once you create a poll questionnaire, you can save it as an .atp file. You can open the file for use 
in any meeting. If you make changes to a poll questionnaire after you save it, you can either save 
the changes to the same file or save a copy of the questionnaire to another file. 

To save a new poll questionnaire: 

1. On the File menu, choose Save > Poll Questions. The Save Poll Questions As dialog box 
appears. 

2. Choose a location at which to save the file. 

3. Type a name for the file. 

4. Click Save. 

Meeting Manager saves the poll questionnaire to a file at the location you specified. Poll 
questionnaire file names have an .atp extension. To save changes to a poll questionnaire that 
you previously saved go to the File menu, choose Save > Poll Questions. Meeting Manager 
saves the changes to the existing poll questionnaire file. To save a copy of a poll questionnaire: 

1. On the File menu, choose Save As > Poll Questions. The Save Poll Questions As dialog 
box appears. 

2. Do either or both of the following: 

�  Type a new name for the file. 

�  Choose a new location at which to save the file. 

Notes 

1. Meeting Center bases the percentage for each answer on the total 
number of attendees in the meeting, not the total number of 
attendees who submitted answers in the questionnaire. 

2. The results of a poll are anonymous—that is, they do not indicate 
which attendees chose which answer 
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3. Click Save. Meeting Manager saves the poll questionnaire to a file at the location you 
specified. The names of poll questionnaire files have an .atp extension. 

Saving Poll Results 
Presenter only  
If you conduct a poll and then share its results, you can save the results to a text, or .txt, file. 
Once you save poll results to a file, you can save changes to the poll results or save a copy of the 
results to another file. To save new poll results: 

1. Close the poll if you have not done so. 

2. On the File menu, choose Save > Poll Results. The Save Poll Results As dialog box 
appears. 

3. Choose a location at which to save the file. 

4. Type a name for the file. 

5. Click Save. Meeting Manager saves the poll results to a file at the location you specified. 
The names of poll results files have a .txt extension. 

To save changes to poll results that you previously saved: 

1. On the File menu, choose Save > Poll Results. 

2. Meeting Manager saves the changes to the existing poll results file. 

To save a copy of a poll results: 

1. On the File menu, choose Save As > Poll Results. The Save Poll Results As dialog box 
appears. 

2. Do either or both of the following: 

�  Type a new name for the file. 

�  Choose a new location at which to save the file. 

3. Click Save. Meeting Manager saves the poll results to a file at the location you specified. 
The names of poll results files have a .txt extension. 

Opening a Saved Poll Questionnaire 
Presenter only 

If you saved a poll questionnaire to a file, you can display the questionnaire during a meeting by 
opening the file. 

 

To open a poll questionnaire file: 

1. On the File menu, choose Open > Poll Questions. The Open Poll Questions dialog box 
appears. 

2. Select the poll questionnaire file that you want to open. The names of poll questionnaire 
files have an .atp extension. 

3. Click Open. The poll questionnaire appears on your Polling panel. You can now open 
the poll to meeting attendees. 

Note  

You can open a poll questionnaire file, which has an .atp extension, only when a meeting is in 
progress. 
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Opening Poll Results 
Presenter only 
If you saved poll results to a file, you can open the file on your 
computer. To open a poll results file on your computer: 
Double-click the saved file, which has a .txt extension. The poll 
results file opens in your default text editor. For each question, 
the poll results show the number and percentage of attendees 
who chose each answer and the total number of attendees in 
the meeting. The following figure shows an example of poll 
results in the text format. 

 

 

 

CHAT 
You can send and receive chat messages to and from meeting participants. All chat messages 
that you either send or receive appear on the Chat panel in the Meeting window. Chat is useful if 
you want to: 

�  Communicate with other participants during a meeting that does not include a voice 
conference 

�  Send a private message to another participant 

�  Send brief information to all participants or a specific group of participants 

�  Ask a question but do not want to interrupt the presenter 

During a meeting, you can manage chat by granting chat privileges or removing them from an 
individual attendee or all attendees. By default, only the presenter has all chat privileges and can 
chat with all participants publicly or privately. However, you can allow all attendees or individual 
attendees to communicate freely during a meeting. You can also remove chat privileges from 
attendees at any time. 

 

Note 

You can designate a participant as a chat moderator to ensure that attendees receive timely 
answers to their questions and to minimize interruptions. The moderator can answer 
attendees© questions via chat messages. At the beginning of the meeting, instruct attendees to 
use chat to ask questions and to direct their questions to the chat moderator. 
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Granting Chat Privileges 
At any time during a meeting, you can specify that all attendees or individual attendees can send 
chat messages to  

�  All Attendees or all participants 
�  Only the meeting host 
�  Only the presenter 
�  Any other attendee, privately 

You can also remove chat privileges at any time. To specify chat privileges for attendees during a 
meeting: 

1. Do either of the following: 

�  On the Chat panel, right-click the Chat title bar, and then choose Attendee Privileges. 

�  In the Meeting window, on the Participant menu, choose Assign Privileges. The 
Assign Privileges dialog box appears. 

2. Do one of the following: 

�  To grant privileges to or remove them from all attendees at once, in the pane on the 
left, select All Attendees. 

�  To grant privileges to or remove them from an individual attendee, in the pane on the 
left, expand All Attendees, and then select the attendee©s name. 

3. Under Communicate, select any of the check boxes for the chat privileges you want to 
grant to the attendees. 4 Click Assign. 

 

 

 

 

Overview of Chat Privileges 
To set attendee chat privileges, in the Meeting Window, on the Participant menu, choose Assign 
Privileges. Then look under Communicate. 

Private 
Chat 

Selected by default, if the host did not specify privileges when scheduling a meeting. 
Specifies that an attendee can chat privately with any other attendee. 

 
 
 
 
 
Chat 
With  

Host —Selected by default, if the host did not specify privileges when scheduling a 
meeting. Specifies that attendees can chat with only the meeting host. If an 
attendee sends a chat message to the host, it appears in only the host©s chat 
viewer. 

Presenter—Selected by default, if the host did not specify privileges when 
scheduling a meeting. Specifies that attendees can chat with only the presenter. If 
an attendee sends a chat message to the presenter, it appears in only the 
presenter©s chat viewer. 

All attendees—Specifies that attendees can chat with either  

�  Other attendees at once, not including the meeting host and the presenter, or 
�   All participants at once, including all attendees, the meeting host, and the 

presenter 
Allow To Contact operator privately—Available only if your site includes the private 

operator option. Lets attendees dial 00 at any time during a teleconference to 
contact the operator for your teleconferencing service.  

Note  

The meeting host and the presenter always have all chat privileges, regardless of 
the chat privileges that other participants have. 
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Sending Chat Messages 

1. In the Meeting window, open the Chat panel. 

2. Type a message in the chat box. 

3. In the Send to drop-down list, select the recipients 
of the message. 

4. Click Send. 

The recipients receive the chat message on their Chat 
panels.  

 

Saving Chat Messages 
You can save chat messages that appear on the Chat panel to a .txt file. You can then reopen 
the file for use in any meeting or view the file©s content outside a meeting by opening the file in a 
text editor. Once you save chat messages to a file, you can save changes to the messages or 
save a copy of them to another file. 
You can save chat messages you have sent or received in a new chat file. 

To save new chat messages: 

1. 1 In the Meeting window, on the File menu, choose Save> Chat. The Save Chat As 
dialog box appears. 

2. Choose a location at which you want to save the file. 

3. Type a name for the file. By default, the name of the previous chat file you saved 
displays. You can save all chat messages in your current meeting to this existing file, or 
save them to a new file. 

4. Click Save. Meeting Manager saves the chat messages in a .txt file at the location you 
selected. 

SHARING PRESENTATIONS, DOCUMENTS AND WHITEBOARDS 
By default, only the presenter can share a document, presentation, or whiteboard during a 
meeting. However, you can allow all attendees or individual attendees to share their own 
presentations or documents or interact with pages, slides, and whiteboards that others share. 
You can also remove these sharing privileges from attendees at any time. To specify attendee 
privileges for shared content in the content viewer: 

1. In the Meeting window, on the Participant menu, choose Privileges. The Attendee 
Privileges dialog box appears. 

2. Do one of the following: 

�  To grant privileges to or remove them from all attendees at once, in the pane on the 
left, select All Attendees. 

�  To grant privileges to or remove them from an individual attendee, in the pane on the 
left, expand All Attendees, and then select the attendee©s name. 

3. Click the Participants tab; then, under Document, select or clear the check boxes for any 
sharing privileges you want to grant to or remove from all or selected attendees: 

�  Save 

�  Print 

�  Annotate 
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4. Under View, select or clear the check boxes for any sharing privileges that you want to 
grant to or remove from all or selected attendees: 

�  Participant list 

�  Any document 

�  Thumbnails 

�  Any page 

5. Under Meeting, select or clear the check boxes to grant to or remove these privileges 
from all or selected attendees: 

�  Record a meeting 

�  Share documents 

�  Control shared applications, or web browser, or desktop remotely 

Sharing Presenations or Documents 

Generally, you can share any type of document or presentation that you can print from your 
computer. Attendees can view the shared document or presentation in their content viewers, 
without the need for the application with which it was created. Attendees can also view any 
animation and transition effects on shared Microsoft PowerPoint slides. Once a meeting starts, 
you can open a document or presentation to share. You do not need to select it or “load” it before 
the meeting. Document and presentation sharing is ideal for presenting information that you do 
not need to edit during the meeting, such as a slide presentation While sharing a document or 
presentation, you can:  

�  Make annotations 

�  Use a pointer to emphasize text or graphics 

�  Save it to a file 

�  Print it 

�  Display it at various magnifications, in miniature (thumbnails), and in a full-screen 
view 

�  Synchronize all participants’ displays with the display in your content viewer  

At any time during a meeting, you can grant attendees privileges that allow them to annotate, 
save, print, and display different views of shared presentations or documents. 

You can share a document or presentation that resides on your computer. Attendees can view a 
shared document or presentation in their content viewers. To share a document or presentation: 

1. On the Share menu, choose Presentation or Document. The Share Presentation or 
Document dialog box appears. 

2. Select the document or presentation that you want to share. 

3. Click Open. The shared document or presentation appears in the content viewer. 

Sharing a Document From Panels 
 
In full-screen view, you have access to sharing and viewing options from the Select Panel menu. 
If you have already opened several documents, you can switch to share any of these documents. 
To display a different document: 

1. On the floating icon tray, click the Select Panel button. It is the last button on the floating 
icon tray. 
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2. On the Select Panel menu, choose Select Document. You see a list of documents that 
are currently open in this meeting. 

3. Select the document you want to share. 

Sharing an Application From Panels 

To display a different document: 

1. On the floating icon tray, click the Select Panel button. It is 
the last button on the floating icon tray.  

2. On the Select Panel menu, choose Select Application. The 
Share Application dialog displays. 

3. Select the application you want to share. Or click New 
Application to open an application not already running on 
your desktop. 

To select another sharing option: 

1. On the floating icon tray, click the Select Panel button. It is 
the last button on the floating icon tray. 

2. On the Select Panel menu, choose Share. You see the list of sharing commands. 

Sharing a Desktop From Panels 
If you are sharing a desktop and want o select another sharing option: 

1. On the floating icon tray, click the Select Panel button. It is the last button on the floating 
icon tray. 

2. On the Select Panel menu, choose Share.  

3. You see a list of Sharing commands Choose the kind of sharing you want to use. 

Sharing a Whiteboard 

Sharing a whiteboard allows you to draw objects and type text that all attendees can see in their 
content viewers. You can also use a pointer to emphasize text or graphics on a whiteboard. While 
sharing whiteboard, you can: 

�  Display it at various magnifications, in miniature (thumbnails), and in a full-screen 
view 

�  Save it 

�  Print it 

�  Synchronize attendees’ displays with the display in your content viewer 

If you grant annotation privileges to attendees, you and attendees can draw and type on a 
whiteboard simultaneously. You can also allow attendees to save, print, and display different 
views of shared whiteboards.  You can share a whiteboard on which you can draw and write. 
Attendees can view a shared whiteboard in their content viewers. 
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To share a whiteboard:  

1. On the Share menu, choose Whiteboard. 

. 

 

 

 

 

 

SHARING SOFTWARE 
While sharing the following types of shared software, you can let an attendee control it remotely: 

�  Application 

�  Desktop 

�  Web browser 

An attendee who has remote control of shared software can interact with it completely. While an 
attendee is remotely controlling your shared software, your mouse pointer is inactive. At any time, 
however, you can take back control of a shared application and regain the use of your mouse 
pointer. While you are sharing software, any attendee can send a request to control the software 
remotely. You can then grant control to the attendee. Alternatively, you can automatically grant 
control of shared software to any attendee who requests remote control. 

 

If you are sharing software, you can let an attendee control it remotely. To let an attendee 
remotely control shared software: 

1. Do either of the following: 

�  In the title bar of a window that you are sharing, click 
the Sharing menu.  

�  In the lower-right corner of your desktop, click the Sharing 
menu.  

 

2. On the menu that appears, choose Allow to Control Remotely > [name of attendee]. 

 

Notes 

�  You can add multiple pages to a shared whiteboard 

�  You can share multiple whiteboards. For each whiteboard that you share, Meeting 
Manager creates a new Whiteboard tab in the content viewer 

Notes 
1. You can stop an attendee from remotely controlling shared software at any time.  
2. An attendee who has remote control of your desktop can run any programs and 

access any files on your computer that you have not protected with a password 
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Automatically Letting Attendees Remotely Control Your Software 

While sharing software, you can automatically grant control of the software to an attendee who 
requests control. In this case, an attendee who requests remote control automatically takes 
control of the software that you are sharing. While automatic remote control is turned on, any 
attendee can take control away from any other attendee by requesting remote control. 

To automatically let attendees control shared software: 

1. Do either of the following: 

�  In the title bar of a window that you are sharing, click 
the Sharing menu.  

�  In the lower-right corner of your desktop, click the Sharing 
menu.  

 

2. On the menu that appears, choose Accept Control Requests Automatically. To stop 
letting attendees control shared software automatically:  

Stopping Remote Control Your Software 

While an attendee is remotely controlling a shared application, desktop, or Web browser, you can 
take back control of the shared software at any time. You can do either of the following: 

�  Take back remote control of shared software temporarily, allowing an attendee to 
take control at any time. 

�  Prevent an attendee from further controlling shared software. 

To temporally take back control of a shared software: On your computer©s desktop, click your 
mouse. You can now control the shared software. The attendee who was controlling the shared 
software can take back control at any time by clicking his or her mouse.  

To prevent an attendee from further controlling a shared software: 

1. On your computer©s desktop, click your mouse. You can now control the shared software. 

2. Do either of the following: 

�  In the title bar of a window that you are sharing, click the Sharing menu. 

�  In the lower-right corner of your desktop, click the Sharing menu. 

3. On the menu that appears, choose Allow to Control Remotely. A menu appears, 
containing a list of all attendees in the meeting. A check mark appears to the left of the 
attendee who has remote control. 

4. Choose the attendee©s name to cancel the selection. 
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SHARING WEB CONTENT 
You can share Web content that resides at a specific address, or URL, on the Web, your 
company’s intranet, or a computer on your network. Web content—which includes Web pages, 
Web pages with embedded media files, or standalone media files—opens in the content viewer 
on each attendee©s computer. If you share a Web page, this option lets participants view and 
interact independently with the content on the page, such as: 

�  Flash animations 

�  Streaming audio 

�  Streaming video 

�  Active Server Pages (ASP) content 

For example, if you want participants to experience audio and video effects on a Web page, you 
can use Web content sharing to open that page on each participant©s computer. However, unlike 
Web browser sharing, this option does not allow you to guide participants to other Web pages. 

You can share a Web page that contains multimedia effects. The page opens in the content 
viewer on each participant©s screen. To share Web content: 

1. On the Share menu, choose Web Content. The 
Share Web Content dialog box appears. 

2. In the Address box, specify the address, or URL, 
at which the content resides. 

3. In the Type box, specify the type of Web content 
that you want to share. 

4. Click OK. 

Web Content Sharing vs. Web Browser Sharing 
Meeting Center provides two options for sharing Web-based information. You can share Web 
content or share a Web browser with meeting participants. Choose the feature that better suits 
your needs. 
 

 Advantages Disadvantages 
Web Content �  Lets you guide attendees to 

various Web pages and sites 
on the Web. 

�  Lets you grant attendees 
control of your Web browser. 

�  Lets you and attendees 
annotate Web pages. 

�  Does not display media effects 
or transmit sounds on Web 
pages. 

�  Does not let attendees interact 
with Web pages 
independently. 
 

Web Browser �  Displays Web pages, and lets 
participants experience media 
effects on Web pages, 
including video and sound. 

�  Lets attendees interact with 
Web pages independently in 
their content viewers. 

�  Does not let you guide 
participants to other Web 
pages. 
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RECORDING 
Distributing recordings of your eMeeting sessions is a powerful method of making meetings 
useful for large groups of participants. Recordings are the next best thing to attending an 
eMeeting session, and provide a great way to keep individuals informed, document what occurred 
at a meeting or even train new employees when you can’t be there in person. You can record part 
or all of a presentation and then make the recording available to others to view later at their 
convenience. 
 
To record audio in a shared UCF multimedia presentation or standalone media file, using WebEx 
Recorder, you must use an audio input device that sends bidirectional audio signals to and from 
your computer©s sound card and your phone  

Recording A Meeting Through EMeeting Controls 

1. On the File menu Click Meeting and Start Recording 

 

 

 

 

 

 

 

 

 

 

2. Save the file in the destination folder with the name you 
choose 

 

 

 

3. Click the Record button (the red one) to start recording the 
session.  

4. Click the Stop Recording  button (the black one) to stop 
recording when you no longer wish to record the session 
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SYSTEM REQUIREMENTS   

Microsoft �  Windows 98, Me, NT, 2000, XP 
�  Intel Pentium processor, 166 MHz  
�  32 MB RAM  
�  56 Kbps Internet connection  
�  Microsoft Internet Explorer 4.x, 5.x or Netscape Communicator 4.x (Netscape 6.0 is not 

supported)  
�  JavaScript and cookies enabled for the browser 
�  56 Kbps or faster Internet connection 

Mac �  Mac OS 10 +  
�  256 MB RAM  
�  Internet Explorer 5.1 + or Netscape Navigator 7 with Java enabled  
�  JavaScript and cookies enabled in the browser  
�  DSL, cable modem, ISDN or faster Internet connection 

�  Mac OS 9  
�  Mac OS 9.0 through 9.2.2  
�  PowerPC Macintosh (G3 or better recommended)  
�  64 MB RAM  
�  Virtual Memory on  
�  QuickTime installed  
�  Netscape Communicator 4.5 through 4.7, or Internet Explorer 5  
�  JavaScript and cookies enabled in the browser  
�  56K or faster Internet connection  

Solaris �  Solaris 5.7 or 5.8 (2.7 or 2.8) or Solaris 9  
�  UltraSPARC or SPARC processor  
�  128 MB RAM  
�  Netscape 4.5x, 4.6x, or 4.7x  
�  Cookies and Java enabled for the browser  
�  16-bit or better video display  
�  CDE or OpenWindows  
�  56 Kbps Internet connection 

Linux (via 
Java client) 

�  Red Hat Linux 6.x - 7.2 or compatible versions of the kernel and XFree86  
�  Intel x86 or compatible processor  
�  128 MB RAM  
�  Netscape 4.78 or 4.79  
�  Cookies and JavaScript enabled in the browser  
�  16-bit or better video display  
�  Gnome 1.x or KDE 2.x  
�  56K or faster Internet connection 

Citrix �  XP SP1, Win 2000 SP4 

Other Info Java Downloader (not available for Solaris) 
Java Client (not available for Solaris) 

�  MSI Installer (Windows Installer that addresses corporate deployment scenarios and provides a 
standard format for component management) 
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FREQUENTLY ASKED QUESTIONS 
Minimum System Requirements  

1. What do I need to host or attend a meeting using Microsoft Windows?  

2. What do I need to host or attend a meeting using Mac OS?  
3. What do I need to host or attend a meeting using Solaris*?  

4. What do I need to host or attend a meeting using Linux*?  

Hosting, Joining, and Setting Up Meetings  

1. Do I have to download software to host a meeting?  

2. What is the difference between the fully functional Meeting Manager and the 
Java Meeting Manager?  

3. Can I use Meeting Manager for Windows if I am a restricted user running 
Windows NT or Windows 2000?  

4. How do I install the fully interactive Meeting Manager manually?  

5. How do I uninstall the fully interactive Meeting Manager?  

Performance  

1. What affects the performance of my meetings?  

2. I have a high-speed Internet connection. Does that help?  

3. What can I do to speed things up? How can I test performance?  

Sharing, Editing, and Annotating  

1. What©s the difference between document sharing and application sharing?  

2. What types of files or applications can I share?  
3. Does everyone in a meeting need the file or application that I want to share? 

How can I modify documents that I©m sharing?  

4. Can I share more than one document or presentation at a time?  
5. Can I save annotated documents or presentations and view them offline?  

6. Can I save annotations made during application sharing or desktop sharing? 

7. Can I show animations and slide transitions in presentations?  
8. Sometimes images we©re sharing don©t look so good. Why?  

9. What happens if people in a meeting have displays of different sizes or 
resolutions?  

10. Why do attendees sometimes see a yellow crosshatched pattern during 
application sharing?  

11. How can I prevent uninvited attendees from joining my meeting? 
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Q: What do I need to host or attend a meeting using Microsoft Windows?  

A: Minimum requirements to host or attend fully interactive meetings using Meeting Manager for Windows:  

 • Windows 95, 98, Me, NT, 2000, or XP  

 • Intel Pentium, 166 MHz  

 • 32 MB RAM  

 • Microsoft Internet Explorer 4, 5, 6, or Netscape Communicator 4  

 • JavaScript and cookies enabled in the browser  

 • 56K or faster Internet connection  

Minimum requirements to attend a meeting using the Java Meeting Manager on Windows: •  

 Microsoft Internet Explorer 4 and 5, or Netscape Communicator 4  

Q: What do I need to host or attend a meeting using Mac OS?  

A: Minimum requirements to host or attend fully interactive meetings using Meeting Manager for Mac OS X:  

 • Mac OS 10.1 or later  

 • 256 MB RAM or more recommended  

 • Internet Explorer 5.1 or later or Netscape Navigator 7 with Java enabled  

 • JavaScript and cookies enabled in the browser  

 • DSL, cable modem, ISDN or faster Internet connection  

Minimum requirements to host or attend fully interactive meetings using Meeting Manager for Mac OS 9:  

 • Mac OS 9.0 through 9.2.2  

 • PowerPC Macintosh (G3 or better recommended)  

 • 64 MB RAM  

 • Virtual Memory on  

 • QuickTime installed  

 • Netscape Communicator 4.5 through 4.7, or Internet Explorer 5  

 • JavaScript and cookies enabled in the browser  

 • 56K or faster Internet connection  

The Java Meeting Manager is not currently compatible with Mac OS.  
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Q: What do I need to host or attend a meeting using Solaris*?  

A: Minimum requirements to host or attend fully interactive meetings using Meeting Manager for Solaris:  

 Solaris 5.7 or 5.8 (2.7 or 2.8) or Solaris 9  

 • UltraSPARC or SPARC processor  

 • 128 MB RAM  

 • Netscape 4.5, 4.6, or 4.7  

 • Cookies enabled in the browser (JavaScript not necessary)  

 • 16-bit or better video display  

 • CDE or OpenWindows  

 • 56K or faster Internet connection  

Minimum requirements to attend meetings using the Java Meeting Manager on Solaris:  

Netscape Communicator 4.6 

Q: What do I need to host or attend a meeting using Linux*? 

A: Minimum requirements to host or attend fully interactive meetings using Meeting Manager for Linux:  

 • Red Hat Linux 6.x - 7.2 or compatible versions of the kernel and XFree86  

 • Intel x86 or compatible processor  

 • 128 MB RAM  

 • Netscape 4.78 or 4.79  

 • Cookies and JavaScript enabled in the browser  

 • 16-bit or better video display  

 • Gnome 1.x or KDE 2.x  

 • 56K or faster Internet connection  

Minimum requirements to attend meetings using the Java Meeting Manager on Linux:  

Netscape Communicator 4.7 

Q: Do I have to download software to host a meeting?  

A: To use all of the interactive features in a meeting, you must run Meeting Manager on your computer. Meeting 
Manager lets you or anyone in the meeting share most types of documents or applications. Unlike the old 
methods of installing software from a disk or downloading and installing it manually over the Internet, your 
meeting service automatically downloads and sets up Meeting Manager for you. In fact, each time you 
participate in a meeting, Meeting Manager maintains itself by checking for the latest version and 
automatically updating itself, as necessary.  

For first-time users, the Meeting Manager for Windows download is approximately 1.0 MB. Meeting Manager 
then downloads only updated components as needed. When scheduling a meeting, you can choose to use 
the Java Meeting Manager, which removes the need for attendees to download software to their computers. 
The Java Meeting Manager is most appropriate for a one-to-many presentation, because it supports fewer 
interactive features than the fully interactive Meeting Manager 
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Q: What is the difference between the fully functional Meeting Manager and the Java Meeting Manager? 

A: To attend a meeting using the Java Meeting Manager, attendees need to run only a small Java applet, 
which allows them to join a meeting quickly. The Java Meeting Manager also allows attendees to join a 
meeting if they are using platforms for which the fully functional Meeting Manager is unavailable. Use of 
the Java Meeting Manager is most suitable for one-to-many presentations, because attendees using the 
Java Meeting Manager cannot act as a host or presenter and use all of the interactive features, as they 
can use the fully interactive Meeting Manager.  

Attendees must use the fully functional Meeting Manager to use all of the functionality that your meeting 
service provides. That©s why we recommend that you use the fully functional Meeting Manager most of 
the time, and use the Java Meeting Manager only when you need to accommodate attendees using 
platforms for which the fully functional Meeting Manager is unavailable.  

When scheduling a meeting, you can require all attendees to use the Java Meeting Manager, by 
selecting the Limited functionality (Java applet) option; or you can allow attendees to use the Java 
Meeting Manager only if a fully functional Meeting Manager is not available for their platforms, by 
selecting the Both option. Note that if you select either of these options, the following limitations apply:  

 • Any shared presentations or documents appear at a lower resolution on all attendees© 
screens.  

 • Any multimedia features in a shared presentation—including slide transitions, animations, 
and rich media—are unavailable.  

If you select the Limited functionality option, these limitations apply for the entire meeting. If you select 
the Both option, these limitations apply once an attendee joins the meeting using the Java Meeting 
Manager.  

Fully Functional Meeting Manager  Java Meeting Manager  

First-time download (1.0 MB on Windows)  Java applet (200K)  

Faster performance during meeting  Faster entry into meeting  
Attendee can become host or presenter and share 
documents, presentations or applications  

Attendees can view the meeting only  

Full toolbar  Limited toolbar  
Windows, Mac OS, Solaris*, Linux*  Windows, Mac OS, Solaris, Linux, other UNIX 

platforms   
Q: Can I use Meeting Manager for Windows if I am a restricted user running Windows NT or Windows 

2000?  

A: If you are a "restricted" user running Windows NT and Windows 2000—that is, a user without 
administrator privileges—the only Meeting Manager restriction you have is that you cannot share 
documents. You can share presentations. In order to share documents, you must either log in to your 
computer as an administrator, then start or join a meeting to automatically setup your computer, or have 
an administrator set up your computer with Meeting Manager for you. After this setup, the restriction on 
sharing documents is removed, and you can share documents without the need to have administrator 
privileges.  
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Q: How do I install the fully interactive Meeting Manager manually?  

A: Instructions for manually installing the fully interactive Meeting Manager are available on the Support page.  

Q: How do I uninstall the fully interactive Meeting Manager? 

A: �  To uninstall Meeting Manager for Windows, use Add/Remove Programs in the Control Panel.  

�  To uninstall Meeting Manager for Mac OS, double-click the installer, then, on the Easy Install menu, 
choose Uninstall.  

�  To uninstall Meeting Manager for Solaris* or Linux*, run wbxsetup, as described on the Support page. 
Then following the instructions on your screen to uninstall the software. 

Q: What affects the performance of my meetings? 

A: Because eMeeting provides real-time collaboration and sharing over the Internet, performance depends on 
both the Internet itself and the eMeeting service. Some of the factors that affect performance are the 
following:  

�  The speed of your computer©s connection to the Internet  

�  The performance of your Internet service provider  

�  Overall Internet traffic on your routed connection to the eMeeting server  

�  Performance of firewall and proxy servers, if your computer is behind a company firewall  

Q: I have a high-speed Internet connection. Does that help?  

A: Although you may have a high-speed connection to the Internet, there can often be congestion or packet loss 
on the Internet, between you and the eMeeting server. You usually can©t do much about such problems, other 
than to inform your network administrator or Internet service provider. Problems are often transient and 
resolve themselves over time. However, you should report serious, persistent problems. Of course, more 
bandwidth usually allows more throughput—but not always. For example, a clear 56K modem connection can 
perform well, while a congested "high speed" T1 connection can seem terrible. Furthermore, a good 
connection won©t help an attendee in a meeting if the presenter has a poor connection. Thus, it©s most critical 
that the presenter have a good connection.  

Q: What can I do to speed things up?  

A: First, get the fastest connection that you can. ISPs are rapidly deploying DSL, cable modem, and T1 
connections. Dial-up modems can do the job, but anything less than 56K is probably too slow. Even with a 
56K modem, your actual connection speed may vary. Next, try using document and presentation sharing 
instead of application or desktop sharing. Document and presentation sharing use less bandwidth. Also, 
sharing documents or presentations that contain fewer graphics can improve performance. Also make sure 
the presenter has a fast connection. It doesn©t help if the attendees are all on T1 connections and the 
presenter is on a slow modem connection. Finally, you can test your connection to determine what is causing 
the problem.  
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Q: How can I test performance?  

A: The Trace Route utility on your computer can help you to determine where problems are occurring between 
your computer and the server. On Windows, open a DOS prompt or a Command prompt window, then type  

tracert themeetingson.webex.com  

When running Trace Route, your computer sends packets of information across your connection to measure 
the amount of time it takes to for the packets to reach the meeting server. Ideally, packets should take 
between 1-60 ms to reach the server. If packets take between 60-100 ms to reach the server, your 
connection is slow and may be noticeable in an eMeeting. Times longer than 100 ms are likely to seem 
unacceptably slow. If you continue to experience poor performance, consult your network administrator. 

Q: What©s the difference between document sharing and application sharing? 

A: Document sharing uses a printer driver to create an image of your document, which is then presented for 
review and markup in the Presentation Window. This image is much like a printed document or fax—that is, 
you cannot edit it. This image requires relatively little bandwidth and thus works well at slower connection 
speeds. On the other hand, application sharing sends images of the application in real-time, allowing you to 
edit documents as well as show all of an application©s features, such as menus and tools. This type of sharing 
is much more powerful and requires more bandwidth. 

Q: What types of files or applications can I share? 

A: You can share virtually any document or application. However, applications with streaming content may not 
work well, because such content is not streaming directly from the source to attendees. However, if you want 
to share a Web page with streaming content, you can use the Web Content sharing feature, which opens a 
browser window on each attendee©s computer and streams the content directly from its source. 

Q: Does everyone in a meeting need the file or application that I want to share? 

A: No. Only the presenter in the meeting must have the file or application on his or her computer. Other 
attendees in the meeting need not have the file or application on their computers. 

Q: How can I modify documents that I©m sharing? 

A: In Presentation or Document sharing mode, you can annotate documents, but not edit them, because the 
content is an image much like a PDF document or fax. However, you can use application sharing to edit 
documents as you share them in a meeting, and save the final version in the native application format. 
Application sharing lets all the attendees see the changes that you make, or edit the document themselves, if 
you grant them remote control.  

Q: Can I share more than one document or presentation at a time? 

A: Yes, you can share as many documents or presentations as you like in the content viewer. Each document or 
presentation that you open appears on its own tab in the content viewer. Because Meeting Manager 
automatically labels each tab with the title or name of the document or presentation, you can quickly locate 
the document or presentation that you want to share with attendees. 

Q: Can I save annotated documents or presentations and view them offline? 

A: Yes! To save any document or presentation in a file on your computer, choose Save on the File menu. To 
view the saved file offline, simply double-click it. The document or presentation appears in the Document 
Viewer, which is part of Meeting Manager. 
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Q: Can I save annotations made during application sharing or desktop sharing? 

A: Yes. To do so, you can record your meeting. A recording captures all annotations and other actions that you 
make during application or desktop sharing. 

Q: Can I show animations and slide transitions in presentations? 

A: Yes! If you share a Microsoft PowerPoint presentation, attendees can see animations and slide transitions in 
their content viewers. Alternatively, you can show animations and slide transitions by using application 
sharing to share your slide-authoring application, then open the slides in that application. 

Q: Sometimes images we©re sharing don©t look so good. Why? 

A: Attendees may see degradation in the quality of some images as the compression algorithm automatically 
compensates for slow connections. This degradation is particularly noticeable on slow connections during 
Web browser sharing. 

Q: What happens if people in a meeting have displays of different sizes or resolutions? 

A: In an eMeeting, all of the attendees© views automatically display the meeting content, even if they have 
different display resolutions. No matter which resolution attendees© monitors are set to, attendees© views 
automatically follow the presenter©s mouse pointer. Thus, the presenter should always keep the mouse 
pointer near the content under discussion. For best results, the presenter should set his or her monitor to 800 
x 600 pixels, because this resolution is the most common. To change your monitor©s display resolution for 
Windows, use the Settings tab in the Display Control Panel. For Mac OS, use the Monitors Control Panel. 

Q: Why do attendees sometimes see a yellow crosshatched pattern during application sharing? 

A: The crosshatched pattern is the shadow of a dialog box or window that is in front of the shared application on 
the presenter©s screen. Once the presenter closes this dialog box or window, the pattern no longer appears.  

Why can©t I bookmark some pages on my eMeeting Web site?  

Your meeting service Web site dynamically generates many of its pages, which you cannot bookmark. 
Please bookmark only the login page. 

Q: How can I prevent uninvited attendees from joining my meeting? 

A: The following are several ways that you can prevent uninvited attendees from joining a meeting:  

�  Specify a password for your meeting. eMeeting automatically includes the password for your meeting in 
an invitation email message to each invited attendee.  

�  Restrict access to your meeting. Once all invited attendees have joined the meeting, you can choose 
Restrict Access on the Meeting menu to prevent others from joining the meeting.  

�  Expel any uninvited attendee from your meeting, by choosing Expel on the Participant menu 
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